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RESUMEN 

 

Los sistemas de información geográfica (SIG) y la hidrología son dos campos de trabajo 

que comparten muchos intereses debido al avance científico y tecnológico es posible 

representar digitalmente la superficie de una cuenca a través de una estructura numérica 

de datos que representa la distribución espacial de una variable cuantitativa y continua, 

cuando la variable a representar es la cota o altura del terreno se denomina Modelo 

Digital de Elevación (MDE), estos grandes aportes ayudan en las diferentes aplicaciones 

del estudio de la cuenca, siendo fundamental para delimitar la cuenca y para la 

determinación de parámetros morfométricos. 

El presente trabajo muestra la delimitación y codificación de las unidades hidrográficas 

de la cuenca del arroyo La Encantada utilizando técnicas de análisis espacial para la 

delimitación y el método Pfafstetter para la división y codificación de estas unidades 

hidrográficas.  

La delimitación de las unidades hidrográficas se desarrolló mediante procesos 

semiautomatizados con el uso de programa (software) ArcGIS.10.1 de sistemas de 

información geográfica SIG y análisis espacial en modelos digitales de elevación MDE, 

creando redes de drenaje hasta la obtención de las cuencas. 

En este trabajo, se han determinado parámetros fundamentales en base a las 

características morfométricas de una cuenca hidrográfica que dan idea de las 

propiedades particulares de cada cuenca; estas propiedades o parámetros facilitan el 

empleo de fórmulas hidrológicas, que generalmente son empíricas, y sirven para 

relacionarlas con los parámetros de forma, drenaje y de relieve. El empleo del SIG 

facilitó el cálculo de los principales parámetros morfométricos de las cuencas, la red 

hidrográfica derivados con el programa ArcGIS.10.1.  

Palabras clave: Subcuencas, Intercuencas, Confluencia, SIG, MDE. Codificación. 

Correo electronico; Mateo Juárez Gomez, oetamhds@gmail.com 
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I INTRODUCCIÓN 

 

Las cuencas hidrográficas representan divisiones naturales del paisaje, también 

funcionan como fronteras naturales de territorios para separar asentamientos territoriales 

tales como países y regiones administrativas las cuales albergan una gran variedad de 

fauna y flora. Dentro de ellas se presentan actividades que ofrecen numerosos servicios a 

la sociedad, como el suministro de agua dulce para uso doméstico, agrícola e industrial, 

estas depende mucho de los caudales que se producen y regulan en las cuencas. Siendo 

el agua para uso agrícola la principal función de las cuencas hidrográficas respecto a su 

rol en una sociedad. 

 

Las cuencas hidrográficas constituyen el contexto idóneo para la planeación y gestión de 

los recursos naturales. Pero la obtención de una imagen clara de la condición de las 

cuencas no es simple; los datos son a menudo limitados y las perspectivas sobre la 

manera de evaluar su estado son distintas entre las diferentes instituciones. La 

complejidad y heterogeneidad de las cuencas requieren el establecimiento de una escala 

geográfica de análisis adecuada para analizar y sintetizar la información disponible, con 

la finalidad de establecer parámetros fundados en un principio precautorio. 

 

La unidad más adecuada para la planificación y gestión de los recursos naturales es la 

cuenca hidrográfica (Cotler, 2010). Este concepto se expresa como un área delimitada 

por la dirección de sus cursos de agua y la superficie del terreno definida por el contorno 

topográfico a partir del cual la precipitación drena por esa sección (López, 1998). De 

manera tradicional, la delimitación de cuencas se ha realizado mediante la interpretación 

de los mapas cartográficos. Este proceso ha ido evolucionando con la tecnología.  

 

Hoy en día, los Sistemas de Información Geográfica (SIG) proporcionan una amplia 

gama de aplicaciones y procesos que permiten realizar de una forma más sencilla y 
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rápida el análisis y delimitación de una cuenca. Con el desarrollo de estas técnicas y 

metodologías, se generan cambios en innovaciones conceptuales con el objeto de que 

puedan ser aplicados en cualquier latitud y se formulen nuevas propuestas que 

incorporen criterios de delimitación y estándares en métodos de clasificación y 

codificación para la demarcación de cuencas hidrográficas. 

 

Es por tal motivo que el presente trabajo ha tenido como objetivo la delimitación y 

codificación de las unidades hidrográficas de la cuenca del arroyo La Encantada, 

aplicando una metodología la metodología de Pfafstetter. La cual es reconocida como 

estándar mundial en la codificación de cuencas a nivel continental.  

 

1.1  Objetivo General 

 

Delimitar la cuenca y unidades hidrográficas del arroyo La Encantada por medio del 

Método Pfafstetter para su división, codificación y determinación de parámetros 

morfométricos  utilizando Sistemas de Información Geográfica (SIG).   

 

1.2  Objetivos Específicos 

 

1. Delimitar la cuenca y unidades hidrográficas. 

2. Determinar parámetros morfométricos y las características de la cuenca. 
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II REVISIÓN DE LITERATURA 

2.1. Cuencas hidrográficas 

 

Las cuencas hidrográficas son espacios territoriales delimitados por un parteaguas 

(partes más altas de montañas) donde se concentran todos los escurrimientos (arroyos 

y/o ríos) que confluyen y desembocan en un punto común llamado también punto de 

salida de la cuenca, que puede ser un lago (formando una cuenca denominada 

endorreica) o el mar (llamada cuenca exorreica). En estos territorios hay una 

interrelación e interdependencia espacial y temporal entre el medio biofísico (suelo, 

ecosistemas acuáticos y terrestres, cultivos, agua, biodiversidad, estructura 

geomorfológica y geológica), los modos de apropiación (tecnología y/o mercados) y las 

instituciones (organización social, cultura, reglas y/o leyes). Las cuencas hidrográficas 

son unidades de manejo integrado de los recursos y servicios que brindan los 

ecosistemas (Swank y Crossley, 1988). 

 

2.2. Manejo de Cuencas Hidrológicas 

 

El manejo de cuencas hidrológicas incluye la manipulación del suelo y de la vegetación 

de un área en particular para reducir la erosión, mejorar la calidad del agua, estabilizar 

descargas, incrementar el suplemento del agua, controlar la infiltración, escurrimiento, 

contaminación y erosión. Debe ser en respuesta a las oportunidades y a los retos de 

protección, rehabilitación y mejoramiento de los objetivos del manejo de cuencas, de las 

libertades individuales y de las metas de los individuos a las cuales pertenecen los 

recursos y quienes, en última instancia, son los que lo manejan (Black, 1996). 

 

2.3. Partes de la cuenca hidrográfica 
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Las partes de una cuenca hidrográfica utilizando el criterio de altura son: parte alta, parte 

media y parte baja. En la parte alta abundan los afloramientos rocosos, materiales 

leñosos y sedimentos más gruesos, con pendientes pronunciadas en las laderas; la 

anchura del cauce es pequeña, los árboles de los lados dan sombra a la mayor parte del 

cauce. En la parte media, el ancho del cauce tiende a ser mayor que en la parte alta, sin 

embargo puede presentarse lo contrario, si el cauce presenta un marcado disturbio. 

 

En la parte baja de la cuenca los cauces tienden a ser todavía más anchos que las partes 

altas y media de la cuenca; el hecho del fondo del cauce presenta sedimentos más finos, 

que se depositan o transportan más fácilmente; las áreas riparias en esta parte de la 

cuenca generalmente se ven impactadas por el uso urbano agrícola y ganadera 

(González, 1998). 

2.4. Tipos de cuencas hidrológicas 

 

Schumm (1977). Menciona que por el destino de los escurrimientos se clasifican en:  

 

 Cuencas arréicas: No vierten sus aguas a los embalses internos ni al mar, los 

escurrimientos se pierden en los cauces por evaporación o infiltración sin 

convertirse en corrientes subterráneas. No existe una red permeable. 

 

 Cuencas criptorréicas: Los escurrimientos se infiltran y corren como ríos 

subterráneos, careciendo de una red fluvial permanente y organizada. 

 

 Cuencas endorréicas o lacustre: El área de captación de la cuenca forma un 

medio de corrientes que desemboca en una represa o lago interior sin llegar al 

mar. 

  

 Cuencas exorréica: El sistema de drenaje llega al mar por vía superficial o 

subterránea. 

 

2.5. Tipos de corrientes 

 

Comúnmente se clasifican en tres tipos: perennes, intermitentes y efímeras, con base en 

persistencia de su escurrimiento o flujo. Las corrientes perennes conducen agua todo el 
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tiempo, excepto en algunas ocasiones durante las sequías extremas. Las corrientes 

intermitentes llevan agua la mayor parte del tiempo pero principalmente en época de 

lluvias o inmediatamente después de ésta, mientras que las corrientes efímeras 

responden a sólo a eventos de lluvia (Leopold, 1994). 

 

2.6. Delimitación de cuencas 

 

Consiste en definir la línea divisoria de las aguas, que es una línea curva cerrada que 

parte y llega al punto de captación o salida mediante la unión de todos los puntos altos e 

interceptando en forma perpendicular a todas las curvas de altitudes del plano o carta 

topográfica, por cuya razón a dicha línea divisoria también se le conoce con el nombre 

de línea neutra de flujo. La longitud de la línea divisoria es el perímetro de la cuenca y la 

superficie que encierra dicha curva es el área proyectada de la cuenca sobre un plano 

horizontal.  

 

La cuenca hidrográfica se puede delimitar por medio de una carta topográfica, que tenga 

suficiente detalle de relieve del terreno. Entre las escalas más comunes se tienen, 1/25 

000 y 1/50 000, aunque para fines de diseño e intervención, las escalas más 

recomendables pueden ser 1/10 000 ó 1/5 000; el tamaño y complejidad del relieve de la 

cuenca indicarán tomar en cuenta la escala más apropiada. Terrenos planos requieren 

más detalle de las curvas de nivel y la escala será mayor, por los contrarios terrenos muy 

accidentados requerirán menor detalle de curvas a nivel y la escala podría ser menor 

(Faustino, 2006). 

 

2.7. Método Pfafstetter  

 

El Sistema de Codificación Pfafstetter fue desarrollado por Otto Pfafstetter en 1989, 

difundido a partir de 1997 por Verdín y adoptado a partir de entonces por la United 

States Geological Survey (UGS – Servicio Geológico de los Estados Unidos), como 

estándar internacional. 
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Es una metodología para asignar Identificadores (Ids) a unidades de drenaje basado en la 

topología de la superficie o área del terreno; asigna Ids a una unidad hidrográfica para 

relacionarla con las unidades hidrográficas que contiene y de las unidades hidrográficas 

con las que limita. 

 

Proceso, que va desde la determinación del río principal, selección de las cuatro redes de 

drenaje de mayor tamaño hasta la generación de las cuencas. 

 

2.7.1 Características de la Metodología 

 

 El sistema es jerárquico y las unidades son delimitadas desde las unidades de los 

ríos (punto de confluencia de ríos), ó desde el punto de desembocadura de un 

sistema de drenaje en el océano. 

 

 A cada cuenca hidrográfica se le asigna un específico código Pfafstetter, basado 

en su ubicación dentro del sistema de drenaje que ocupa, de tal forma que éste es 

único dentro al interior de un continente. 

 

 Este método hace un uso mínimo de la cantidad de dígitos en los códigos, la 

longitud del código depende solamente del nivel que se está codificando. 

 

 La distinción entre río principal y tributario, es en función del área de drenaje. 

Así, en cualquier confluencia, el río principal será siempre aquel que posee la 

mayor área drenada entre ambos. 

 

 Este sistema de codificación permitirá asimismo, una eficiente codificación de la 

red hidrográfica. 
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 El código de la unidad hidrográfica provee información importante como el tipo 

de unidad de drenaje, nivel de codificación y ubicación al interior de la unidad 

que lo contiene (Ruiz y Torres, 2008). 

2.7.2 Tipos de Unidades Hidrográficas 

 

El sistema Pfafstetter describe tres clases de unidades de drenaje: cuenca, intercuenca y 

cuenca interna. 

 

Cuenca: área que no recibe drenaje de ninguna otra área, pero sí contribuye con flujo a 

otra unidad de drenaje a través del curso del río, considerando como principal, al cual 

confluye. 

 

Intercuenca: área que recibe drenaje de otra unidad aguas arriba, exclusivamente, del 

curso del río considerado como el principal, y permite el paso de éste hacia la unidad de 

drenaje contigua hacia aguas abajo. En otras palabras, una intercuenca, es una unidad de 

drenaje de tránsito del río principal. 

 

Cuenca interna: área de drenaje que no recibe flujo de agua de otra unidad ni contribuye 

con flujo de agua a otra unidad de drenaje o cuerpo de agua. 

 

La distinción entre río principal y tributario, está en función del criterio del área drenada. 

Así, en cualquier confluencia, el río principal será siempre aquel que posee la mayor 

área drenada entre ambos. Denominándose cuencas a las áreas drenadas por los 

tributarios e intercuencas a las áreas restantes drenadas por el río principal (Ruiz y 

Torres, 2008). 

 

2.7.3 Proceso de Codificación 

 

Para iniciar el proceso de codificación se debe en principio determinar el curso del río 

principal de la unidad que se va codificar. Una vez determinado el curso del río 
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principal, se determinan las cuatro unidades hidrográficas de tipo cuenca, que son las 

cuatro unidades de mayor área que confluyen al río principal. 

 

Las cuatro unidades tipo cuenca se codifican con los dígitos pares 2, 4, 6 y 8, desde 

aguas abajo hacia aguas arriba; es decir, desde la desembocadura hacia la naciente del 

río principal. Las otras áreas de drenaje se agrupan en unidades hidrográficas de tipo 

intercuenca, y se codifican, también desde aguas abajo (desde la confluencia) hacia 

aguas arriba, con los dígitos impares 1, 3, 5, 7 y 9. (Ver Figura 2.1). 

 

Por la metodología de delimitación y codificación de las unidades hidrográficas, el 

código 9 siempre resulta o se reserva para la unidad de drenaje de mayor tamaño de la 

parte superior de la cuenca o cabecera de cuenca la misma que generalmente contiene el 

origen del río cuya unidad de drenaje se está codificando. 

 

Cada una de las unidades de drenaje de tipo cuenca o intercuenca, delimitadas y 

codificadas en un determinado nivel (por ejemplo el primero) se pueden a su vez 

subdividir y codificar siguiendo exactamente el proceso antes descrito, de modo que por 

ejemplo la delimitación y codificación de la unidad de drenaje tipo cuenca de código 8 

se subdivide y codifica en nueve unidades hidrográficas, cuatro de tipo cuenca códigos 

82, 84, 86 y 88 y cuatro de tipo intercuenca de códigos 81, 83, 85 y 87 así como la 

unidad hidrográfica de cabecera de código 89. El mismo proceso se aplica a las unidades 

de tipo intercuenca, de modo que por ejemplo la unidad tipo intercuenca de código 3, se 

subdivide en las unidades de tipo cuenca de códigos 32, 34, 36 y 38 y en las unidades 

tipo intercuenca 31, 33, 35, 37 y 39. Los códigos de las unidades menores deben llevar 

siempre al inicio el código o los dígitos de la unidad que lo contiene.  

 

El proceso de codificación consiste en: subdividir una cuenca hidrográfica, cualquiera 

que sea su tamaño, determinándose los cuatro mayores afluentes del río principal, en 

términos de área de sus cuencas hidrográficas. Todas estas áreas pueden ser subdivididas 

hasta describir el último trecho de la red de drenaje, generando subdivisiones de nivel 

“n” (Aguirre, 2005). 
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Figura 2.1. Proceso de codificación del Sistema Pfafstetter 

 

2.7.4 Particularidades del método 

 

 Una complicación puede aparecer en que las dos unidades finales y más altas del 

río principal, son cuencas. En este caso la unidad que presente mayor área de 

drenaje es asignado el código “9” y la otra, más pequeña, el código “8”. Esta 

particularidad del método permite identificar la cuenca donde se origina el río. 

(Ver Figura 2.2). 

 

 

 

 

 

Se delimitan las cuatro 

mayores 

Cuencas tributarias. 

Se delimitan intercuencas. Red de drenaje original, 

previo 

Determinación del rio 

principal. 
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Figura 2.2 Proceso de codificación del Sistema Pfafstetter – Caso especial 

 

 Si un área contiene cuencas internas, la cuenca interna más grande es asignado 

código “0” y las otras cuencas internas son incorporadas a las cuencas o 

intercuencas aledañas (Ver Figura 2.3). 

 

 

 

 

 

 

 

 

Figura 2.3. Proceso de codificación del Sistema Pfafstetter – Cuencas internas. 

 

 Si una unidad hidrográfica contiene más de una unidad tipo cuenca interna o 

endorréica, se asigna el código “0” en el nivel que corresponda a la unidad de 

mayor tamaño y las otras unidades se incorporan a las unidades que lo contienen 

en el siguiente nivel. 

 

 Para las regiones hidrográficas cuyas unidades drenan de forma paralela a los 

océanos, el sistema de codificación de Pfafstetter determina que se identifique las 

cuatro unidades hidrográficas de mayor área de drenaje y luego la asignación de 
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códigos se realiza considerando el sentido de las agujas del reloj, es decir las 

vertientes cuyas aguas desembocan en un mar oriental, serán codificadas de norte 

a sur; y las vertientes cuyas aguas desemboquen en un mar occidental, (como es 

el caso de la vertiente del Pacífico), serán codificadas de sur a norte. La 

subdivisión y codificación en los subsiguientes niveles se realizará siguiendo el 

mismo criterio. 

 

 Cuencas internas cuya red de drenaje confluye en una laguna, Es uno de los 

casos más comunes de unidades cerradas, en las cuales los ríos que descienden 

por sus laderas desembocan en la zona más baja de ésta conformando un lago o 

laguna.  

 

No es posible en este caso determinar un curso o río principal, en tal sentido se 

definen primero las cuatro unidades de mayor extensión que constituirán las 

cuencas, y luego las áreas de drenaje comprendidas entre las cuatro cuencas 

constituirán las unidades tipo intercuenca que también serán cuatro unidades; 

añadiéndose a las anteriores una novena unidad que será constituida por el 

mismo cuerpo de agua ubicado en la parte inferior. La codificación de las 

unidades es en sentido horario, iniciando por la cuenca que se encuentre más al 

nor‐oeste, a la cual se le asignará el código 2. 

 

 Cuencas internas que poseen un colector principal, son aquellas unidades 

cerradas donde si es posible distinguir un flujo principal, el cual puede encontrar 

a lo largo de su recorrido algunos lagos o lagunas, los mismos que serán 

considerados como parte de este.  

 

Luego de definir el cauce principal, se determinan las cuatro unidades 

hidrográficas de mayor extensión que constituirán las unidades tipo cuenca y las 

áreas de drenaje comprendidas entre la cuencas pasarán a constituir las cinco 

unidades de tipo intercuenca, cuya delimitación respectiva, de ser necesario, 

atravesarán los cuerpos de agua tipo laguna, considerados como parte del curso 
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principal. La codificación se realizará, siguiendo el criterio establecido por el 

método desde la parte más baja hacia la más alta de la unidad de drenaje. 

 

 Cuencas internas cuya red de drenaje confluye en un punto común, sin conformar 

necesariamente una laguna. En este caso los ríos confluyen en un cuerpo de agua 

incipiente o inexistente, esto puede ser debido a que son cuerpos o espejos de 

agua temporales o en vías de extinción. 

 

Para este caso, la información topográfica es de mucha utilidad, pues al ser 

información captada por radar posee información del relieve aún debajo del 

agua, lo cual posibilita determinar unidades hidrográficas en esa zona. Debido a 

que todos los cursos confluyen en un punto común o en un área común de muy 

poca extensión, las unidades interiores que se forman son de tipo cuenca.  

 

La codificación, al igual que en el caso anterior, se realiza desde la unidad más al 

noroeste, siguiendo el sentido horario para la codificación del resto de las 

unidades; la unidad que se forme debajo del agua llevará el código 1. 

 

 Cuencas internas conformadas también por un conjunto de cuencas internas o 

cerradas. Son unidades características de la Región Hidrográfica 0, y se 

presentan en la parte central de ésta región o unidad hidrográfica, conformando 

un grupo de unidades endorreicas independientes. La única manera de poder 

agruparlas en unidades mayores es eligiendo las cumbres de mayor altitud que 

las circundan como límites. Serán consideradas las nueve de mayor tamaño. 

 

La delimitación de unidades menores sigue el mismo procedimiento anterior, 

apoyándose de los valores de altitud de sus cumbres, se conformarán en lo 

posible nueve agrupaciones, considerándose las de mayor tamaño. La inspección 

de la morfología del terreno también es de mucha ayuda. La codificación como 

en los casos anteriores, sigue el mismo sentido, pero esta vez, iniciándose con el 

código 1. 
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 Unidades hidrográficas o Cuencas arreicas. Son aquellas que presentan cursos de 

agua de bajo caudal, los cuales desaparecen durante su recorrido debido a 

filtración o evaporación, lo que permite la formación de unidades cerradas. Estas 

unidades, así formadas, seguirán el mismo procedimiento de codificación de 

cualquier unidad interna, cuyos casos o variantes de delimitación y codificación 

ya han sido descritos anteriormente. 

 

 Islas. Este es otro de los casos especiales. Estas porciones de territorio si se 

encuentran cercanas a la costa, serán consideradas para la codificación parte de la 

unidad hidrográfica continental más cercana, asumiendo el código de ésta, en el 

nivel que se encuentre. 

 

En consecuencia, se debe considerar si las unidades hidrográficas tienen áreas de 

drenaje suficientemente extensas como para ser consideradas entre las cuatro 

unidades tipo cuenca (Ruiz y Torres, 2008). 

 

2.8. Parámetros morfológicos 

 

Las características físicas y biofísicas de una cuenca hidrográfica tienen estrecha 

relación con el comportamiento de las lluvias y de los caudales que por ella transitan. La 

escasa información hidrológica, meteorológica, geológica y cartográfica disponible hace 

que investigar dicha relación no sea fácil. No se puede garantizar que toda la 

información  morfométrica  de las cuencas utilizadas en un estudio se pueda obtener en 

una misma escala, lo que aumenta el grado de incertidumbre. 

 

Caracterización cuantitativa de los rasgos propios de la corteza terrestre que permiten 

compararlos y establecer en forma previa relaciones hidrológicas de generalización. A 

pesar de la incertidumbre su uso se hace indispensable. Se seleccionan los parámetros 

más relevantes para el análisis del proyecto hidrológico que se investiga. 
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La caracterización de una cuenca está dirigida fundamentalmente a cuantificar todos los 

parámetros que describen su estructura física y territorial con el fin de establecer las 

posibilidades y limitaciones de sus recursos naturales pero también para identificar los 

problemas presentes y potenciales. (Umaña, 2002). 

 

Los parámetros morfológicos o características geomorfológicas de una cuenca 

hidrográfica dan una idea de las propiedades particulares de cada cuenca; estas 

propiedades o parámetros facilitan el empleo de fórmulas hidrológicas. 

 

2.9 Parámetros de forma 

2.9.1 Área de la cuenca (A) 

 

La superficie de la cuenca corresponde a la proyección de ésta en un plano horizontal; y 

su tamaño influye en forma directa sobre las características de los escurrimientos. La 

unidad de medida es en km
2
. 

2.9.2 Perímetro (P) 

 

El perímetro de la cuenca (P), es definido por la longitud de la línea de división de 

aguas, que se conoce como el “parte aguas o Divortium Acuarium”. La unidad de 

medida es en km. 

2.9.3 Longitud de la cuenca (L) 

 

Longitud de la cuenca queda definida como la distancia horizontal, medida a lo largo del 

cauce principal, entre el Punto de Salida de la Cuenca (desde el cual queda definida) y el 

límite definido para la cuenca, esta línea es paralela al cause principal. 
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2.9.4 Cota inicial y cota final del cauce principal. 

 

Altura máxima y altura mínima (msnm): Elevación sobre el nivel del mar del punto más 

alto y más bajo de la cuenca hidrográfica. 

2.9.5 Coeficiente de compacidad de Gravelius (Kc).  

 

Coeficiente de Compacidad (Kc) o Índice de Gravelius (1914). Es la relación entre el 

perímetro de la cuenca y el de una circunferencia; sus resultados estarán basados en la 

clasificación de Campos (1992) mostrados en el Cuadro 2.1. Cuánto más cercano esté el  

índice a la unidad, la cuenca será más circular y por tanto más compacta, y en la media 

que aumenta, la cuenca adquiere una forma más oval. Este se obtiene al relacionar el 

perímetro de la cuenca, con el perímetro de un círculo, que tiene la misma área de la 

cuenca. 

La fórmula de Gravelius, está dada por: 

        
 

  
 

Donde: 

 Kc: Coeficiente de compacidad de Gravelius 

 P: Perímetro de la cuenca en km.  

A: Área de la Cuenca en km
2 

Cuadro 2.1 Formas de la cuenca de acuerdo al Índice de compacidad.
 

Clase de Forma. Índice de Compacidad (Cc) Forma de la Cuenca 

 

Clase I 1.0 a 1.25 Casi redonda a oval-red 

Clase II 1.26-1.50 Oval-redonda a oval oblonga onda 

Clase III 1.51 a más de 2 Oval-oblonga a rectangular-oblonga 

(Campos, 1992) 
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2.9.6 Relación de elongación (R)  

 

Esta relación fue definida por Schumm, (1977) como el cociente entre el diámetro de un 

círculo con la misma superficie de la cuenca y la longitud máxima de la cuenca, definida 

como la más grande dimensión de la cuenca, a lo largo de una línea recta desde la salida 

hasta el límite extremo del parteaguas, paralela al río principal (Díaz et al, 1999). 

Su expresión matemática es: 

        
  

 
 

Donde: 

R= Relación de elongación (adimensional) 

L = Longitud de la cuenca (km) 

A = Área de la cuenca (km
2
) 

La fórmula anterior, es la más extendida para calcular este índice debido a la alta 

correlación que guarda con la hidrología de la cuenca. Valores cerca a la unidad 

implicará formas redondeadas y cuanto menor sea a la unidad, será más alargada 

(González, 2004). 

2.9.7 Factor Forma (F) 

 

Factor de Forma (F). Este factor fue propuesto por Horton (1945) donde relaciona el 

área de la cuenca y la longitud de la misma. En este sentido, valores inferiores a la 

unidad indican cuencas alargadas y aquellos cercanos a uno, son redondeados (Ver 

Cuadro 2.2). Se estima a partir de la relación entre área de captación y la longitud de la 

cuenca, longitud que se mide desde la salida hasta el punto más alejado a ésta. 

El factor de forma, viene dado por:  
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Donde:   

L: Longitud de la cuenca (km). 

A: Área de captación (km
2
) 

 

Este factor relaciona la forma de la cuenca con la de un cuadrado, correspondiendo un  

F= 1 para regiones con esta forma, que es imaginaria. Un valor de (F) superior a la 

unidad nos proporciona el grado de achatamiento de la cuenca o el de un río principal 

corto. En consecuencia, con tendencia a concentrar el escurrimiento de una lluvia 

intensa formando fácilmente grandes crecidas.  

Cuadro 2.2 Formas de la cuenca de acuerdo al Factor Forma. 

 

 

 

 

 

2.10 Parámetros de drenaje 

2.10.1 Patrón de drenaje (Pd) 

 

El patrón o red de drenaje es el sistema de cauces o corrientes por el que fluyen los 

escurrimientos superficiales de manera temporal o permanente. Su importancia se 

manifiesta por sus efectos en la formación y rapidez de drenado de los escurrimientos 

normales o extraordinarios además de proporcionar síntomas sobre las condiciones 

físicas del suelo y de la superficie de la cuenca. Entre los patrones más comunes se 

puede encontrar el paralelo, dendrítico, enrejado, angular, contorneado, entre otros 

(Deagostini, 1978). En la Figura 2.4 se observan los principales patrones de drenaje en 

las zonas montañosas (Howard, 1967). Relaciona la disposición del drenaje con el medio 

geológico y establece una serie de drenajes tipo en función de la estructura. 

Clases de valores de forma 

Rangos de F Clases de forma 

0.01 - 0.18 Muy poco achatada 

0.18 - 0.36 Ligeramente achatada 

0.36 - 0.54 Moderadamente achatada 



 
18 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 2.4. Patrones de drenaje típicos, los cuales pueden ocurrir a escalas 

variables. (Howard, 1967)  

 

2.10.2 Número de orden de cauce. 

 

El orden de cauce es una clasificación que refleja el grado de ramificación o bifurcación 

dentro de una cuenca (Linsley 1977). 

Horton (1945), sugirió la clasificación de cauces de acuerdo al número de orden de un 

río como una medida de la ramificación del cauce principal de una cuenca hidrográfica. 

Un río de primer orden es un tributario pequeño sin ramificaciones. Un río de segundo 

orden posee únicamente ramificaciones de primer orden. Un río de tercer orden es uno 

que posee ramificaciones de primero y segundo orden. Un río de cuarto orden es uno 

que tiene ramificaciones de primer orden, segundo y tercer orden, y así sucesivamente. 
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El orden de una cuenca hidrográfica está dado por el número de orden del cauce  

principal. 

Entonces el orden de la corriente o colector principal será un indicador de la magnitud 

de la ramificación y de la extensión de la red dentro de la cuenca. 

Al respecto la determinación del cauce principal, se lleva acabo del punto de salida de la 

cuenca hacia aguas arriba, siguiendo a la corriente de más alto orden, hasta alcanzar una 

bifurcación de dos corrientes de igual orden, entonces, la rama o cauce que tenga una 

mayor área de cuenca es seleccionado; a partir de tal punto el proceso se repite hasta 

terminar un tributario de orden uno. 

Este índice indica el grado de estructura de la red de drenaje. En general, mientras mayor 

sea el grado de corriente, mayor será la red y su estructura más definida se clasifica de 

acuerdo al Cuadro 2.3. Asimismo, un mayor orden indica en general la presencia de 

controles estructurales del relieve y mayor posibilidad de erosión o bien, que la cuenca 

podría ser más antigua (en determinados tipos de relieve) 

Cuadro 2.3 Clases de orden de cauce. 

Rangos de ordenes Clases de orden 

1-2 Bajo 

2-4 Medio 

4-6 Alto 

 

2.10.3. Longitud total de los cursos de agua (Lt) 

 

Es la suma de la distancia total recorrida por los diferentes cursos de agua que forman 

parte de la red hidrográfica de la cuenca. La distancia recorrida por un curso de agua se 

mide desde su origen hasta su desembocadura en el cuerpo receptor. 
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2.10.4 Densidad de drenaje (Dd) 

 

La cantidad de ríos y quebradas que llegan o tributan al río principal dentro del área de 

la cuenca se conoce como densidad de drenaje. Este es un parámetro revelador del 

régimen y de la morfología de la cuenca, porque relaciona la longitud de los cursos de 

agua con el área total. De esta manera, los valores altos reflejan un fuerte escurrimiento 

(Ver Cuadro 2.4)  

 

   
  

 
 

Donde: 

Dd = Densidad de drenaje (km/km
2
) 

Lt = Longitud total de los causes (km)  

A = Área total de la cuenca (km
2
) 

 

Este es un índice importante, puesto que refleja la influencia de la geología, topografía, 

suelos y vegetación, en la cuenca hidrográfica, y está relacionado con el tiempo de salida 

del escurrimiento superficial de la cuenca. Una densidad de drenaje alta, refleja una 

cuenca muy bien drenada que debería responder, relativamente rápido, al influjo de la 

precipitación. Una cuenca con baja densidad de drenaje refleja un área pobremente 

drenada, con respuesta hidrológica muy lenta (Villón, 2002). 

Cuadro 2.4 Clases de densidad de drenaje. 

 

 

 

 

 

 

 

Rangos de Densidad Clases 

0.1 – 1.8 Baja 

1.9 – 3.6 Moderada 

3.7 – 5.6 Alta 
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2.11 Parámetros de relieve 

 

2.11.1 Pendiente media de la cuenca 

 

Tiene una importante pero compleja relación con la infiltración, el escurrimiento 

superficial, la humedad del suelo y la contribución del agua subterránea al flujo en los 

cauces. Es uno de los factores físicos que controlan el tiempo del flujo superficial y tiene 

influencia directa en la magnitud de las avenidas o inundaciones. Caracterización de 

relieve según Heras (1976) ver Cuadro 2.5. 

Pendiente media de la cuenca es la longitud total de todas las curvas de nivel (LCN) 

comprendidas dentro de la cuenca (km), (D) es la equidistancia entre curvas de nivel del 

mapa topográfico (km) y A es el área de la cuenca (km
2
). 

                                                          
     

 
 

Cuadro 2.5 Clasificación de pendientes. 

Pendiente en % Tipo de terreno 

2 Llano 

5 Suave 

10 Accidentado medio 

15 Accidentado 

25 Fuerte Accidentado 

50>50 Escarpado Muy escapado 

 

2.11.2. Pendiente y perfil del cauce principal 

 

La pendiente del colector principal se relaciona con las características hidráulicas del 

escurrimiento, en particular con la velocidad de propagación de las ondas de avenidas y 

con la capacidad para el transporte de sedimentos (Klohn, 1970).La Pendiente del cauce 
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principal es la relación entre la altura total del cauce principal (cota máxima menos cota 

mínima) entre la longitud del cauce principal. 

2.12 Curvas características de la cuenca 

2.12.1 Curva hipsométrica 

 

La curva hipsométrica sugerida por Langbein (1947), proporciona una información 

sintetizada sobre la altitud de la cuenca, que representa gráficamente la distribución de la 

cuenca vertiente por tramos de altura. Dicha curva presenta, en ordenadas, las distintas 

cotas de altura de la cuenca, y en abscisas la superficie de la cuenca que se halla por 

encima de dichas cotas, bien en km
2
 o en tanto por cien de la superficie total de la 

cuenca. 

De esta curva se puede obtener una importante relación: 

   
  

  
 

Donde Ss y Si son, respectivamente, las áreas sobre y bajo la curva hipsométrica. Según 

Strahler mencionado por Llamas (1993) la importancia de esta relación reside en que es 

un indicador del estado de equilibrio dinámico de la cuenca. Así, cuando Rh = 1, se trata 

de una cuenca en equilibrio morfológico. La Figura 2.5 muestra tres curvas 

hipsométricas correspondientes a otras tantas cuencas que tienen potenciales evolutivos 

distintos. 

 

 

 

 

 

 

 

 

Figura 2.5. Curvas hipsométricas, características del ciclo de erosión (según 

Strahler). 
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La curva superior (curva A) refleja una cuenca con un gran potencial erosivo; la curva 

intermedia (curva B) es característica de una cuenca en equilibrio; y la curva inferior 

(curva C) es típica de una cuenca sedimentaria. 

2.12.2 Polígono frecuencias de altitudes 

 

Representa el grado de incidencia de las áreas comprendidas entre curvas de nivel con 

respecto al total del área de la cuenca (Ibáñez et al, 2011). 

 

2.12.3 Alturas características 

 

Altura media. Es la ordenada media de la curva hipsométrica. 

Altura más frecuente. Es la altitud cuyo valor porcentual es el máximo de la curva de 

frecuencia de altitudes. 

Altitud de frecuencia media. Es la altitud correspondiente al punto de abscisa media 

(50 % del área) de la curva hipsométrica (Villón, 2002). 
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III MATERIALES Y MÉTODOS 

3.1  Descripción de la zona de estudio  

 

3.1.1 Ubicación 

 

El arroyo La Encantada.- Esta corriente tiene su formación en la parte sur del Municipio 

de Saltillo en el poblado denominado la Encantada y en las sierras del municipio de 

Arteaga, siguiendo una trayectoria hacia el este pasando por la ciudad de Saltillo y 

Ramos Arizpe y el poblado de Paredón, con una longitud de 77 Km hasta su confluencia 

con el arroyo Patos y sus escurrimientos se aprovechan para riego, principalmente en el 

municipio de Ramos Arizpe (CONAGUA, 2011) Figura 3.1. 

En su paso por Saltillo, a este arroyo se le conoce como “El Pueblo”. Después de su 

confluencia con el arroyo Cárdenas (o Madre), al sur del municipio de Ramos Arizpe, 

recupera su nombre. 

 

Figura 3.1. Área estudio perteneciente a la cuenca del arroyo la Encantada 
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3.1.2. Clima 

 

El tipo de clima del área de estudio de acuerdo a la clasificación Köppen y modificada 

por García (1973). Es predominado por el seco estepario (BS) para las partes altas de 

cuenca y el muy árido o muy secos (BW) para el área de la desembocadura de la cuenca 

(Ver Figura 3.2). 

La temperatura media es de 18°C a 22°C, la temperatura del mes más frio es menor de 

18°C y temperatura  del mes más caliente mayor de 22°C.Los subtipos de climas son el 

semiseco, templado, grupos de climas secos  y semifríos. 

 

 Figura 3.2. Tipos de clima de área de la cuenca del arroyo La Encantada. 

 

3.1.3. Precipitación 

 

La precipitación promedio anual en el estado se encuentra representado en seis rangos 

que van desde 100 mm hasta los 700 mm, el rango que mayor porcentaje estatal que se 

reporta es de 400-500 mm con un 32.80% y el mínimo de 200-300 mm con una 
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superficie de 3.77% del estado. Por su parte la precipitación promedio anual en el 

municipio de Saltillo está en un rango de 300 a 400 mm; con un régimen de lluvias de 

los meses de abril, mayo, junio, julio, agosto, septiembre y octubre siendo escasa en 

noviembre, diciembre, enero, febrero y marzo, siendo igual para el área de 

correspondiente a la cuenca del arroyo la Encantada (CONAGUA, 2009). 

 

3.1.4. Provincias fisiográficas  

 

El área de la cuenca se encuentra totalmente ubicado en provincia fisiográfica de la 

Sierra Madre Oriental. Cuya principal característica geológica de esta provincia es la 

predominancia de rocas mesozoicas de origen sedimentario marino, las cuales fueron 

sometidas a esfuerzos corticales de tensión y compresión, que dieron lugar a 

levantamiento serranos abruptos constituidos por rocas calizas, que se alternan con 

valles intermontanos. Esta provincia se caracteriza por sus estructuras geológicas que 

han dado lugar a la formación de valles y sierras, cuyas orientaciones predominantes son 

noreste-sureste y este-oeste. Existe un gran número de fallas normales e inversas, así 

como de pliegues anticlinales y sinclinales que siguen la orientación de las sierras. Las 

estructuras ígneas se encuentran diseminadas en la parte de la provincia que corresponde 

al estado y están constituidas por cuerpos intrusivos y derrames de lava. También 

existen fracturas de diferentes magnitudes, algunas de las cuales has sido rellenadas por 

soluciones mineralizantes para formar vetas de importancia económica, como es el caso 

de las minas de verita, fluorita y de minerales metálicos (Dow AgroSciences de México 

S.A. de C.V. 2012). 

 

3.1.5. Subprovincias Fisiográficas 

 

Las subprovincias fisiográficas que abarca el área de la cuenca de arroyo La Encanta son 

la Gran Sierra Plegada la cual en menor proporción y se ubica en la zona de la naciente 
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de la corriente del arroyo en la parte de Arteaga. Y la subprovincia Pliegues Saltillo-

Parras que está presente en la mayoría de área de la cuenca (Ver Figura 3.3). 

La  Gran Sierra Plegada la región flexionada al este de Saltillo y sur de Monterrey se 

conoce como Anticlinorio de Arteaga, un anticlinorio es la sucesión estructural de 

pliegues, que juntos integran un anticlinal general. La parte oeste del Anticlinorio de 

Arteaga es lo que de esta Subprovincia corresponde a Coahuila, y está constituida por 

los sistemas de topoformas designados sierra pliegue flexionada, bajada, bajada con 

sierras y valle intermontano. Esta porción cubre 2,178.18 km
2
 de la superficie total 

estatal, y abarca partes importantes del municipio de Arteaga (95%) y una fracción muy 

reducida del de Saltillo. Suelos presentes en ésta subprovincia: En la Subprovincia 

dominan los Litosoles, los cuales se presentan asociados a Rendzinas y Regosoles 

calcáricos. También se encuentran Xerosoles háplicos y cálcicos. 

La subprovincia los Pliegues Saltillo-Parras los 9,195.35 km
2
 de la mitad sur de esta 

Subprovincia se encuentran incluidos dentro del territorio del estado de Coahuila, 

incluye partes de los municipios de Parras, General Cepeda, Saltillo, Arteaga, Ramos 

Arizpe, Castaños, Candela y Monclova. Suelos presentes en ésta subprovincia: Los tipos 

de suelo presentes en esta región son Litosoles, Regosoles calcáricos, Luvisoles 

crómicos, Xerosoles háplicos y cálcicos, Fluvisoles, Rendzinas, Feozems calcáricos, 

Castañozems y Solonchak órticos (Dow AgroSciences de México S.A. de C.V. 2012). 
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Figura 3.3. Mapa de subprovincias fisiográficas 

 

3.1.6.  Regiones hidrológicas 

 

La cuenca de arroyo La Encantada se localiza dentro la región hidrológica (RH24) de la 

cuenca Rio Bravo – San Juan. (B) y subcuenca Rio San Miguel (e), teniendo como clave 

(RH24Be) hasta su delimitación como subcuenca  como se muestra en la Figura 3.4. 

La Región Hidrológica Bravo-Conchos (No. 24). En su mayoría está constituida por 

tierras planas, con altitud media de 1000 m a 1800 m. Es una región árida cuya sequedad 

se agudiza el norte. La mayoría de las corrientes del norte desaguan en el río Bravo, y 

hay además algunas cuencas endorreicas, como las de las lagunas Tortuguillas y 

Chancaplio, dentro del área de la cuenca del río Conchos. 

 

La cuenca del Río San Juan pertenece a la región hidrológica río Bravo-San Juan (24 B), 

con una superficie de alrededor de 32,972 Km², comprendida entre las coordenadas 

25°15' y 26°45' de latitud norte, 99°15' y 101°45' longitud oeste, abarca parte de los 



 
29 

estados de Coahuila, Nuevo León y Tamaulipas. La mayor parte de esta cuenca está 

dentro del estado de Nuevo León. 

Figura 3.4. Localización de la cuenca arroyo la Encantada en la Región Hidrológica 

Rio Bravo. 

 

3.2. Metodología 

3.2.1 Delimitación de la cuenca. 

 

La selección del área de estudio se realizó con las cartas topográficas escala 1:50,000 

G14C23 San Miguel, imagen digital, Coordenadas: O 101°00 - O 101°20/N 25°30 - N 

25°45.  G14C24 Ramos Arizpe, imagen digital, Coordenadas: O 100°40 - O 101°00/N 

25°30 - N 25°45. Carta G14C33 – Saltillo, imagen digital, Coordenadas: O 101°00 - O 

101°20/N 25°15 - N 25°30. Carta G14C34 – Arteaga, Imagen digital, Coordenadas: O 

100°40 - O 101°00/N 25°15 - N 25°30. Las cuales se delimitaron las 4 unidades tipo 

subcuencas y 5 unidades intercuencas se delimitaron en pantalla con el programa 

ArcGIS 10.1 se realizó los 9 polígonos de las unidades hidrográficas y los cauces de la 

cuenca del arroyo La Encantada. 
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3.2.2. Método semiautomático para delimitación de cuencas. 

 

Existen maneras de delimitar o delinear cuencas hidrográficas, cada una de ellas se 

utiliza de acuerdo del carácter o propósito que se desee alcanzar. Las maneras de 

delimitar que van desde las realizadas manualmente, sobre un plano topográfico o 

directamente en pantalla, hasta las que se realizan digitalmente de forma 

semiautomática, con las herramientas SIG y con la información base geoespacial. 

Todas las formas de delimitar conducen al mismo objetivo, sin embargo, la diferencia 

radica en la precisión; y es allí donde el método que se utilice y la información base, 

determinarán la calidad del trabajo final. 

Para la delimitación de cuencas hidrográficas  es necesario contar con un Modelo Digital 

de Elevación de la zona de estudio, para ello se procesaron cartas digitales MDE 

correspondientes al flujo del agua del arroyo La Encantada.  

3.2.3.  Mosaico del MDE  

 

Unir dos o más ráster desde un mosaico de imágenes en ArcGIS, es un proceso 

sumamente sencillo y muy útil cuando se necesita fusionar varios modelos de elevación 

digital o imágenes ráster dentro en uno solo, cabe señalar que los datos de entradas 

deben contener la misma cantidad de bandas, profundidad de bit; caso contrario, la 

herramienta se cerrará con un mensaje de error. 

Se trabajó con cuatros archivos correspondientes a las cartas que cubre el territorio de 

estudio, con la herramienta Mosaic To New Raster del ArcToolbox.  

ArcToolbox > Data Management Tools > Raster > Raster Dataset > Mosaic to New 

Raster 

En esta herramienta en Input Raster agregar los rásters, definir el directorio de salida, la 

extensión del nuevo archivo (img), referencia espacial (WGS84_14N) y el número de 

bandas (1), el resto de campos son opcionales (configurar de acuerdo a nuestras 

necesidades), aceptar y el resultado se muestra al final como se observa en la Figura 3.5. 
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Figura 3.5. Mosaico del modelo de elevación digital de área de estudio 

 

Un modelo digital de elevación es una representación visual y matemática de los valores 

de altura con respecto al nivel medio del mar, que permite caracterizar las formas del 

relieve y los elementos u objetos presentes en el mismo. 

Estos valores están contenidos en un archivo de tipo raster con estructura regular, el cual 

se genera utilizando equipo de cómputo y software especializados. 

En los modelos digitales de elevación existen dos cualidades esenciales que son la 

exactitud y la resolución horizontal o grado de detalle digital de representación en 

formato digital, las cuales varían dependiendo del método que se emplea para generarlos 

y para el caso de los que son generados con tecnología LIDAR se obtienen modelos de 

alta resolución y gran exactitud (valores submétricos). 

3.2.4.  Fill 

Una vez que se ha cargado el DEM del área de estudio, se procede con la “herramienta 

fill” con esta herramienta se rellenan las imperfecciones existentes en la superficie del 

modelo digital de elevaciones, de tal forma que las celdas en depresión alcancen el nivel 

del terreno de alrededor, con el objetivo de poder determinar de forma adecuada la 

dirección del flujo. (Figura 3.6) 

Para ello a partir de ArcToolbox > Spatial Analyst Tools > Hydrology > Fill,  

Como resultado se obtiene el raster de correcciones del MDE. 
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Figura 3.6. Corrección del modelo de elevación digital 

 

3.2.5 Flow Direction 

 

La dirección del flujo está determinada por la dirección más empinada de descendencia 

de cada celda o pixel o caracterización de los pixeles en función de las pendientes que se 

tengan, buscando el camino descendente para indicar por donde el flujo correría en caso 

de escurrimientos (Figura 3.7).  

Para establecer la dirección del flujo hidrológico de la pendiente se procede  con la 

herramienta Flow Direction. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Direcction 

Como resultado se obtiene el raster de dirección del flujo. 

 

 

 

 

 

 

Figura 3.7. Raster de dirección del flujo 
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3.2.6 Flow accumulation. 

 

Crea el raster de acumulación de flujo en cada celda. Se determina el número de celdas 

de aguas arriba que vierten sobre cada una de las celdas inmediatamente aguas abajo de 

ella. Construye sobre la base de la dirección del flujo los causes principales como se 

muestra en la Figura 3.8. Para determinar la acumulación del flujo de las celdas que 

fluyen hacia cada celda descendiendo sobre la pendiente se utiliza la herramienta Flow 

Accumulation. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Flow Accumulation 

 

 

 

 

 

 

Figura 3.8. Raster de flujo acumulado 

 

3.2.7 Stream definition. (Determinación del umbral de acumulación) 

 

Consiste en determinar el flujo de acumulación adecuado que permita a su vez obtener 

las unidades de drenaje (watersheds) según la metodología Pfafstetter: “cuatro unidades 

de drenaje tipo cuenca (cuencas cuyas áreas de drenaje sean las más grandes) y cinco 

unidades de drenaje de tipo inter‐cuenca (que incluye a la unidad de drenaje de 

cabecera”. Se debe indicar que las mayores áreas de drenaje corresponden a las unidades 

con las mayores acumulaciones de flujo. Por tanto las cuatro tributarios con las mayores 

acumulaciones de flujo de una cuenca, corresponden a las cuatro mayores áreas de 

drenaje. 



 
34 

Este es un procedimiento iterativo de ensayo y error; siendo la manera más sencilla de 

determinar el umbral de acumulación adecuado para obtener los tributarios necesarios. 

En este ensayo, se debe procurar que la acumulación de flujo elegida finalmente, sea lo 

suficientemente adecuada para visualizar el flujo principal y cuatro tributarios, sin 

importar que tan pequeños puedan ser éstos; basta tan sólo que aparezca un pixel como 

flujo tributario para ser considerado como tal.  

En esta fase se clasifican las celdas con acumulación de flujo superior a un umbral 

especificado por el usuario como celdas pertenecientes a la red de flujo. El umbral debe 

ser especificado como el número de celdas vertientes a la que se está clasificando en 

cada momento. Aquí se debe entrar a sopesar que valor sería el más indicado, ya que si 

el valor de acumulación es muy bajo muchos pixeles serán seleccionados como 

pertenecientes a la red hídrica, si por lo contrario, el valor del pixel es muy alto solo 

aquellos drenajes de orden alto serían definidos como red hídrica. En otras palabras, 

seleccionar un valor bajo del umbral significa que obtendremos afluentes pequeños en 

nuestra red de drenajes, en cambio un valor alto, modela los drenajes de mayor tamaño 

(Ver Figura 3.9). 

Recodar que para la delimitación basada en el sistema de Otto Pfasftetter  se tienen que 

identificar al interior de la cuenca a lo largo del arroyo principal los cuatro tributarios 

con mayor volumen que contribuyan con flujo hídrico y descarguen directamente hacia 

el primero, donde se ubicarán cuatro confluencias, que indican el punto de unión entre 

los arroyos. Para crear una  red de corriente a partir del raster de acumulación de flujo, 

se procede de la siguiente forma.  

a. En el menú de la barra de herramienta desplegable de Spatial Analyst  selecciona la 

Calculadora Raster. 

ArcToolbox > Spatial Analyst > Map Algebra > Raster Calculator.  

b. Con el fin de crear una red de drenajes, tendrá que especificar un umbral para  la 

cantidad de píxeles adyacentes que constituyen una corriente. Aquí vamos a especificar 

un valor límite de alto píxeles de acumulación. Necesitaremos formar cuatro 
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confluencias con el arroyo principal para ello se necesitara hacer pruebas hasta 

obtenerlas.  

Después de hacer varias pruebas para la obtención de las 4 confluencias hacia el arroyo 

principal (paso c) se consiguió con un valor límite de 325000 píxeles de acumulación. 

c. En la calculadora raster escribimos la expresión siguiente: 

Stream_Red = Con (“FlowAcc_Flow.” > 325000, 1) 

Como resultado se obtiene el raster red de flujo  

 

 

 

 

 

 

 

Figura 3.9. Raster red de flujo muestra el arroyo principal y los cuatro tributarios 

de mayor tamaño. 

 

Una vez obtenido el umbral adecuado para visualizar los cuatro tributarios de mayor 

tamaño se realizó el cálculo de los umbrales con drenajes de más pequeños para obtener 

un panorama más amplio de los tipos de unidades de drenaje que describe el sistema 

Pfafstetter: cuenca, intercuenca y cuenca interna. El cual se obtuvo con el mismo 

proceso descrito anteriormente.  

En este caso: stream_Red = con (FlowAcc_flow1 > 124500, 1). 
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3.2.8 Stream Link 

 

Divide el cauce en segmentos no interrumpidos. Es decir, que dichas secciones en las 

que se divide el recorrido del flujo serán segmentos que conectan dos uniones sucesivas, 

una unión y un punto de desague o una unión y una división del área de drenaje ver 

Figura 3.10. Para ello se procede de la siguiente forma. 

ArcToolbox > Spatial Analyst Tools > Hydrology > Stream Link 

Como resultado se obtiene el siguiente raster. 

 

Figura 3.10. Segmentos no interrumpidos. 

 

3.2.9 Stream to Feature 

 

Crea un shape de drenajes. El procedimiento es el siguiente: ArcToolbox > Spatial 

Analyst Tools > Hydrology > Stream Feature. 

Como resultado se obtiene la red de flujo en vector (Ver Figura 3.11). 
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Figura 3.11. Shape de red hidrográfica. 

  

3.2.10 Watershed  

Para la generación automática de watersheds – cuencas hidrográficas ‐, se requiere 

principalmente de la dirección de flujo y el enlace de cursos o “stream link” (Ver Figura 

3.12). Ciertamente, no es el único método de generación de unidades de drenaje o 

watersheds, ya que existen otras técnicas que emplean datos de tipo puntual como los 

puntos de desembocadura o “pour points”, que se emplea para generar de forma 

controlada por el usuario la unidades de drenaje o watersheds.  

Se definen las cuencas hidrográficas del sistema. El procedimiento es el siguiente: 

ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed. Como resultado se 

obtiene la delimitación de las cuencas. 
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Figura 3.12. Shape de cuencas hidrográficas del área de estudio. 

 

3.2.11 Raster to Polilyne. 

 

Ahora que se ha elaborado la red hídrica, convertir el ráster a shapefile con la 

herramienta Raster to Polyline (Ver Figura 3.13). 

ArcToolbox > Conversion Tools > From Raster > Raster to Polyline 

Como resultado se obtiene el polígono de las cuencas. 

 

 

 

 

 

Figura 3.13. Polígono de las cuencas del área de estudio 
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3.2.12 Generación Vectorial de Unidades Hidrográficas 

 

Extrae entidades de entrada que se superponen a las entidades del clip. Esto es 

particularmente útil para crear una nueva clase de entidad, también conocida como área 

de estudio o área de interés , que contenga un subconjunto geográfico de las entidades de 

otra clase de entidad mayor. 

Se procede a recortar el polígono del perímetro de la cuenca del arroyo La Encantada. 

Considerando el cauce principal y los cuatro afluentes que están dentro del sistema que 

queremos delimitar y codificar. 

Para ello es necesario seleccionar el área de estudio con la herramienta select features o 

selección de entidades que permite identificar o trabajar con un subconjunto de 

entidades en el mapa como se observa en la Figura 3.14. 

Para seleccionar entidades se utiliza la herramienta select features  en la barra de 

herramientas. Con el puntero del ratón, se hace clic en el área a seleccionar, para agregar 

las demás solo se mantiene presionando la tecla  shift, hasta tener completar el área de 

estudio a recortar. 

 

  

  

  

 

 

Figura 3.14. Selección del área de la cuenca de la arroyo La Encantada. 
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Se procede con la extracción del polígono como se resultado se obtiene el recorte de la 

cuenca del arroyo (Ver Figura 3.15). 

ArcToolbox > Analysis Tools > Extract> Clip 

 

 

  

 

  

  

  

Figura 3.15. Recorte del área de la cuenca de la arroyo La Encantada. 

 

3.2.13. Obtención de Unidades hidrográficas 

 

Se radia líneas sobre los parteaguas cercanos partiendo de estos puntos de unión 

(confluencia) hacia la parte alta del área de drenaje. El resultado de este proceso será la 

obtención de nueve territorios, intercuencas son áreas que drenan directamente hacia el 

río principal y a las subcuencas son áreas que drenan hacia un principal a través de un 

tributario. Como resultado se obtuvieron 4 subcuencas y 5 intercuencas. Ver Figura 

3.16. 

 

 

 

 

 

 

 

Figura 3.16. Subcuencas e intercuencas del arroyo la Encantada. 
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3.3. Determinación de parámetros morfológicos. 

 

Con el área de la cuenca del arroyo La Encantada ya digitalizada, se realizaron las 

mediciones de los parámetros físicos con la ayuda del programa ArcGIS.10.1 y el calculó 

algunos parámetros mediante las ecuaciones ya citadas. La determinación de los parámetros 

se realizó para el área total de la cuenca y para las 4 unidades tipos subcuencas obtenidas. 

 

3.4. Parámetros de forma. 

 

Mediante el programa ArcGIS.10.1 y con el área de la cuenca ya digitalizada se realizaron 

los cálculos de estos parámetros área, perímetro, y longitud de la cuenca, con la ayuda de 

herramientas de ArcGIS mediante la tabla de atributos, se agregaron los campos a calcular 

y se hizo uso del cálculo de la geometría de la cuenca se checaron las unidades en 

kilómetros cuadrados posteriormente se corrió y se obtuvo el área y perímetro y con la 

extensión 3D analyst para obtener la longitud de la cuenca se hizo uso de measure 

(herramienta de ArcGIS 10.1) con el cual se obtuvo el resultado directo de la longitud de la 

cuenca. El coeficiente de compacidad (Kc) se calculó de acuerdo a la fórmula de Gravelius 

(1914). La relación de elongación (R) se obtuvo aplicando la fórmula de Schumm (1977). 

El factor forma (F) se calculó mediante la ecuación propuesta por Horton (1945). 

 

3.5. Parámetros de drenaje. 

 

El patrón de drenaje se determinó mediante la clasificación de Howard (1967) relaciona la 

disposición del drenaje con el medio geológico y establece una serie de drenajes tipo en 

función de la estructura. El número de orden de cauce se realizó para la cuenca total del 

arroyo La Encantada y para las cuatro unidades tipo subcuenca a través de la herramienta 

Stream Order de ArcGIS.10 usando el método propuestos por Strahler (1957). En el 

método de Strahler, se asigna un orden de 1 a todos los vínculos sin afluentes y se los 
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conoce como de primer orden. La longitud total de los cursos de agua (Lt) es la medición 

lineal de la longitud total de cauces (L) se realizó con la suma total del número de causes 

mediante la ayuda de la tabla de atributos se calculó la longitud expresada en km. Para la 

densidad de drenaje se aplicó la formula ya mencionada en la revisión de literatura. 

 

3.6. Parámetros de relieve. 

 

La pendiente media de la cuenca se calculó a través de un mapa de pendientes interpolado 

con datos de altimetría de la cuenca, las herramientas utilizadas para este proceso fueron 

Slope y Zonal Statistics as Table de ArcGIS.10.1, donde se obtuvo el resultado en 

porcentaje de la pendiente media de la cuenca. La pendiente del cauce principal se obtuvo 

con la relación entre la altura total del cauce principal (cota máxima menos cota mínima) 

entre la longitud del cauce principal. La curva hipsométrica se obtuvo a través de 

ArcGIS.10 con la generación de un archivo TIN del área de cuenca, del cual se creó un 

raster que se reclasificó con 8 clases y curvas a cada 300 metros para el área total de la 

cuenca empezando con la cota menor a la cota más alta de la cuenca. Para determinar el 

área que hay en las curvas clasificadas a cada 300 metros se usó la herramienta Zonal 

Statistics as Table donde se tomó dato del área que se pasó a Km
2
 para generar la tabla de 

construcción de la curva hipsométrica. El polígono frecuencias de altitudes se realizó con 

tabla de construcción de la curva hipsométrica graficando Área/Área Total [por ciento] y 

alturas. Las Alturas características se calcularon con la ayuda de la curva hipsométrica y del 

polígono de frecuencias de altitudes tomando en cuenta que la altura media es la ordenada 

media de la curva hipsométrica, la altura más frecuente es la altitud cuyo valor porcentual 

es el máximo de la curva de frecuencia de altitudes y la altitud de frecuencia media es la 

altitud correspondiente al punto de abscisa media (50 % del área) de la curva hipsométrica. 

 3.7. Productos obtenidos 

 

Mapa de delimitación y codificación de la cuenca y cauces de los arroyos. Mapas las 4 

unidades hidrográficas tipo subcuenca y cauces de los arroyos. Parámetros morfométricos 

del área total de cuenca y de las 4 subcuencas obtenida. 
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IV RESULTADOS 

4.1. Delimitación de la cuenca  

 

Para el presente estudio, se partió con base al mapa elaborado por el Eros Data Center 

(USGS, 1997) a nivel mundial, que da inicio de la delimitación continental separando el 

continente en América del Norte y América del Sur; por lo tanto América del Norte se 

delimita para el Nivel 1 en 9 cuencas, correspondiéndole a México y Centroamérica el 

digito 9, correspondiente a una intercuenca tal como se muestra en la Figura 4.1. 

 

Figura 4.1. Delimitación continental de las cuencas de América del Norte, Nivel 1, 

Método Pfafstetter. 

 

Para el nivel 2 el USGS delimita a nivel continental 80 cuencas, para nuestro caso se 

observa área delimitada correspondiente a la intercuenca con el código 9  correspondiente a 

México y Centroamérica donde se encuentra el área de estudio de la cuenca el arroyo La 

Encantada la cual  se ubica en la cuenca con código 92 como se muestra en la Figura 4.2. 
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Figura 4.2. Delimitación continental de las cuencas de América del Norte, Nivel, 2 

Método Pfafstetter. 

Dando que México no utiliza el método Pfasftetter para la delimitación de su cuencas se 

parte asumiendo que área del arroyo La Encantada es de nivel 3 para ejemplificar la 

aplicación del método, ya que para realizar su aplicación a nivel continental y generar los 

códigos correspondientes, se necesita delimitar el área correspondiente con el código 92 

hasta llegar al área del arroyo La Encantada generando así, niveles mayores que 

representarían mosaicos cada vez más finos de la superficie del terreno en unidades de 

drenaje más pequeñas. 

El resultado de la delimitación del área de estudio consistió en subdividir el territorio 

llamado cuenca del arroyo La Encantada, ubicando las cuatro confluencias en la 

desembocadura de los cuatro tributarios más importantes sobre el río principal, y a partir de 

ahí, como indica la metodología, se generó nueve territorios que de acuerdo con su 

ubicación respecto a éste serán intercuencas o subcuencas,  se obtuvieron  9 unidades 

hidrográficas 4 cuencas y 5 intercuencas como se observa en la Figura 4.3. 
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Figura4.3. Delimitación las cuencas del arroyo La Encantada, Método Pfafstetter. 
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4.2. Codificación de la cuenca en el nivel 3 

En el nivel 3 de la cuenca, queda comprendida 9 unidades, codificadas con códigos 921, 

923, 925, 927,929 para  las intercuencas y 922, 924, 926 y 228 para las subcuencas como se 

muestra en la Figura 4.4.  

 

Figura 4.4. Codificación  las cuencas del arroyo La Encantada, Método Pfafstetter 
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4.3. Morfología de la cuenca del arroyo La Encantada. 

En la Figura 4.5 se observa el área total de la cuenca así como los cauces de los arroyos y 

las curvas a nivel. Los parámetros de forma, drenaje y los de relieve se analizaron en una 

sola serie para el área completa de la cuenca ver Cuadro 4.1. 

 

Figura 5.5. Área total de la cuenca con cauces y curvas de nivel. 
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4.3.1. Parámetros de forma. 

 

Esta cuenca cuenta con un área de 1169.81 km
2
 el área de la cuenca tiene gran importancia, 

por constituir el criterio de la magnitud del caudal, en condiciones normales, los caudales 

promedios, mínimos y máxima instantáneos crecen a medida que crece el área de la 

Cuenca. 

Tiene un perímetro de 242.80 km, si bien el perímetro es una medida o parámetro que no 

indica nada por si solo se convierte en un insumo fundamental para el cálculo de los 

parámetros de forma de la cuenca al igual que la longitud de la cuenca que es de 49.45 km. 

El coeficiente de compacidad de Gravelius es de 1.99, se considera una cuenca de clase III 

de acuerdo a la clasificación de Campos (1992) es Oval-oblonga a rectangular-oblonga. 

Parámetro que indica que la duración de escurrimiento de la lámina de agua será menor al 

tener que recorrer menos longitud en cauces secundarios. A mayor coeficiente menos 

redonda es la forma de la cuenca y más rápidamente alcanza la lámina de agua el cauce 

principal (Maldonado et al, 2001). 

La relación de elongación es de 0.78  los valores de (R) inferiores a 1, implican formas 

alargadas. Los índices bajos obtenidos, indican cuencas poco circulares y corresponden a 

cuencas de montaña, escarpadas y alargadas (Jardí, 1985) 

El factor de forma de la cuenca es de 0.48 de acuerdo a las clases de valores de forma 

moderadamente achatada. Una cuenca con un factor de forma bajo esta menos sujeta a 

crecidas y se caracteriza por ser una cuenca alargada, con un colector de mayor longitud 

que la totalidad de los tributarios. 

4.3.2. Parámetros de drenaje 

 

Patrón de drenaje el patrón de drenaje observado en la cuenca fue el dendrítico se 

caracteriza por tener materiales aproximadamente homogéneos en composición, sin control 

estructural, constituye uno de los patrones más comunes y se presenta en muchos ambientes 

de acuerdo a Howard (1967) los cuales pueden ocurrir a escalas variables. 
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Número de orden de cauce de acuerdo a la clasificación de Horton (1945) fue de clase 

media correspondiente a un cauce de tercer orden que posee ramificaciones de primero y 

segundo orden. Como se observa en la Figura 4.6. Entre más alto es el orden de la cuenca, 

indica un drenaje más eficiente que desalojará rápidamente el agua.  

 

 

Figura 4.6. Mapa de número de orden de cauces. 
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Longitud total de los cursos de agua este parámetro fue medido a través de suma total de 

órdenes de cauces, el cual fue de 171 km. El resultado de este valor se utiliza para definir la 

densidad de drenaje de la cuenca. 

La densidad de drenaje fue de 0.15 es una cuenca de clase baja refleja un área pobremente 

drenada, con respuesta hidrológica muy lenta. 

4.3.3. Parámetros de relieve 

Pendiente media de la cuenca fue de 14 %  de acuerdo a la caracterización de relieve según 

Heras  que representa un suelo accidentado a  medio accidentado que evidentemente 

favorece parcialmente la escorrentía, favoreciendo el escurrimiento superficial y 

potenciando algunos procesos erosivos. 

La pendiente del cauce principal fue del 17% favorece la escorrentía y procesos erosivos. 

La curva hipsométrica proporciona una información sintetizada sobre la altitud de la 

cuenca, que representa gráficamente la distribución de la cuenca vertiente por tramos de 

altura. La curva hipsométrica es una distribución del área de acuerdo con la elevación, es 

decir, una representación bidimensional, que grafica en el eje vertical la elevación y en el 

eje horizontal el porcentaje del área sobre cada curva de nivel, en términos del área total 

como se muestra en la Figura 4.7.  

 

 

 

 

 

 

 

Figura 4.7. Curva Hipsométrica de la cuenca del arroyo La Encantada. 
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Al comparar la curva hipsométrica de cuenca del arroyo La Encantada que se muestra en la 

Figura 4.7, con las curvas propuestas por Strahler, citado por Llamas (1993), es posible 

señalar que esta cuenca se encuentra en una etapa intermedia (curva B) es característica de 

una cuenca en equilibrio. 

El polígono de frecuencia de altitudes para la cuenca del arroyo La Encantada se muestra 

en la siguiente Figura 4.8. 

 

 

 

 

 

 

Figura 4.8. Frecuencia de altitudes de la cuenca del arroyo La Encantada. 

Con las figuras de la cuerva hipsométrica y el polígono de frecuencias de alturas se 

determinan las alturas características. Altura media: 1900 msnm es la ordenada media de la 

curva hipsométrica. Altura más frecuente: 1750 msnm es la altitud cuyo valor porcentual es 

el máximo de la curva de frecuencia de altitudes. Altitud de frecuencia media: 1832 msnm 

Es la altitud correspondiente al punto de abscisa media (50 % del área) de la curva 

hipsométrica. 

Cuadro 4.1 Resumen de resultados de valores morfológicos para la cuenca del arroyo 

La Encantada 
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4.4. Morfología de la Subcuenca 922 

 

En la Figura 4.9 se observa el área correspondiente a la subcuenca 922  así como los cauces 

de los arroyos. Los parámetros de forma, drenaje y los de relieve se analizaron en una sola 

serie para esta área ver Cuadro 4.2. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 4.9. Área de la subcuenca 922 
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4.4.1 Parámetros de forma. 

 

Esta subcuenca cuenta con un área de 344.73 km
2
, tiene un perímetro de 113.70 km, la 

longitud de la cuenca es de 32.5 km. El coeficiente de compacidad de Gravelius es de 1.71, 

se considera una cuenca de clase III de acuerdo a la clasificación de Campos (1992) es 

Oval-oblonga a rectangular-oblonga. La relación de elongación es de 0.64 los valores de 

(R) inferiores a 1, implican formas alargadas. El factor de forma de la  cuenca es de 0.33 de 

acuerdo a las clases de valores de forma ligeramente achatada. 

 

4.4.2. Parámetros de drenaje 

 

Patrón de drenaje el patrón de drenaje observado en la cuenca fue el dendrítico, el número 

de orden de cauce de acuerdo a la clasificación de Horton (1945) fue de clase baja a media 

correspondiente a un cauce de segundo orden que posee únicamente ramificaciones de 

primer orden.  

Longitud total de los cursos de agua este parámetro fue medido a través de suma total de 

órdenes de cauces, el cual fue de 44 km el resultado de este valor se utiliza para definir la 

densidad de drenaje de la cuenca. 

La densidad de drenaje fue de 0.13 es una cuenca de clase baja refleja un área pobremente 

drenada, con respuesta hidrológica muy lenta. 

 

4.4.3. Parámetros de relieve 

 

Pendiente media de la cuenca fue de 13 %  de acuerdo a la caracterización de relieve según 

Heras  que representa un suelo medio accidentado que favorece parcialmente la escorrentía, 

favoreciendo el escurrimiento superficial y potenciando algunos procesos erosivos. La 

pendiente del cauce principal fue del 13%. 
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En la Figura 4.10 se aprecia la curva hipsométrica de la subcuenca 922 la cual presenta el 

comportamiento de la elevación y el área acumulada que proyecta la subcuenca es posible 

señalar que esta cuenca se encuentra entre la etapa intermedia (curva B) es característica de 

una cuenca en equilibrio y la curva inferior (curva C) es típica de una cuenca sedimentaria. 

 

 

 

 

 

 

 

 

Figura 4.10. Curva Hipsometrica de la subcuenca 922 del arroyo La Encantada. 

El polígono de frecuencia de altitudes para la subcuenca 922 del arroyo La Encantada se 

muestra en la siguiente Figura 4.11. 

 

Figura 4.11. Polígono de frecuencia de altitudes para la subcuenca 922. 
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Con las figuras de la cuerva hipsométrica y el polígono de frecuencias de alturas se 

determinan las alturas características. 

Altura media: 1900 msnm es la ordenada media de la curva hipsométrica. Altura más 

frecuente: 1700 msnm es la altitud cuyo valor porcentual es el máximo de la curva de 

frecuencia de altitudes. Altitud de frecuencia media: 1852 msnm es la altitud 

correspondiente al punto de abscisa media (50 % del área) de la curva hipsométrica. 

Cuadro 4.2 Resumen de resultados de valores morfológicos para la subcuenca 922 

 

 

4.5. Morfología de la Subcuenca 924 

 

En la Figura 4.12 se observa el área correspondiente a la subcuenca 926 así como los 

cauces de los arroyos. Los parámetros de forma, drenaje y los de relieve se analizaron en 

una sola serie para esta área ver Cuadro 4.3. 

Cuenca
Área 

(km
2
)

Perímetro 

(km)

Longitud de 

la cuenca 

(km)

Cota Inicial 

del cauce 

(msnm)

Cota 

Finalde 

cauce 

(msnm)

Índice de 

Compacidad 

(K): 

Relación 

de 

elongación 

(R): 

Factor de 

forma  (F): 

Patrón de 

drenaje 

(Pd)

Subcuenca 

922
344.73 113.70 32.5 1900 1505 1.71 0.64 0.33

DENTRIFICO

.

Cuenca

Número 

de orden 

de cauce.

Longitud 

total de los 

causes 

(km)

Densidad de 

drenaje

Longitud 

total Cauce 

Principal 

(km)

Pendiente 

media de la 

cuenca (%)

Pendiente 

cauce 

principal 

(%)

Altitud 

media de la 

Cuenca 

(msnm)

Altitud 

más 

frecuente: 

(msnm)

Altitud de 

Frecuencia 

media 

(msnm)

Subcuenca 

922
2 44 0.13 31 13 13 1900 1700 1852
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Figura 4.12. Área de la subcuenca 924 
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4.5.1. Parámetros de forma. 

 

Esta subuenca cuenta con un área de 75.90 km
2
, tiene un perímetro de 50.74 km, la longitud 

de la cuenca es de 16.40 km. El coeficiente de compacidad de Gravelius es de 1.63, se 

considera una cuenca de clase III de acuerdo a la clasificación de Campos (1992) es Oval-

oblonga a rectangular-oblonga. La relación de elongación es de 0.60 los valores de (R) 

inferiores a 1, implican formas alargadas. El factor de forma de la cuenca es de 0.28 de 

acuerdo a las clases de valores de forma  es ligeramente achatada. 

 

4.5.2. Parámetros de drenaje 

 

El número de orden de cauce de acuerdo a la clasificación de Horton (1945) fue de clase 

baja correspondiente a un cauce de primer orden.  

Longitud total de los cursos de agua este parámetro fue medido a través de suma total de 

órdenes de cauces, el cual fue de 9 km. El resultado de este valor se utiliza para definir la 

densidad de drenaje de la cuenca. 

La densidad de drenaje fue de 0.12 es una cuenca de clase baja refleja un área pobremente 

drenada, con respuesta hidrológica muy lenta. 

 

4.5.3. Parámetros de relieve 

 

Pendiente media de la cuenca fue de 13 % de acuerdo a la caracterización de relieve según 

Heras  que representa un suelo medio accidentado que favorece parcialmente la escorrentía, 

favoreciendo el escurrimiento superficial y potenciando algunos procesos erosivos.La 

pendiente del cauce principal fue del 9%. 

En la Figura 4.13 se aprecia la curva hipsométrica de la subcuenca 924 la cual presenta el 

comportamiento de la elevación y el área acumulada que proyecta la subcuenca es posible 
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señalar que esta cuenca se encuentra en la etapa intermedia (curva B) es característica de 

una cuenca en equilibrio y la curva inferior (curva C) es típica de una cuenca sedimentaria. 

 

 

 

 

 

 

 

 

Figura 4.13. Curva Hipsometrica de la subcuenca 924 del arroyo La Encantada. 

 

El polígono de frecuencia de altitudes para la subcuenca 924 del arroyo La Encantada se 

muestra en la siguiente Figura 4.14. 

 

Figura 4.14. Polígono de frecuencia de altitudes para la subcuenca 924. 
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Con las figuras de la cuerva hipsométrica y el polígono de frecuencias de alturas se 

determinan las alturas características. Altura media: 1800 msnm es la ordenada media de la 

curva hipsométrica. Altura más frecuente: 1535 msnm es la altitud cuyo valor porcentual es 

el máximo de la curva de frecuencia de altitudes. Altitud de frecuencia media: 1808 msnm 

es la altitud correspondiente al punto de abscisa media (50 % del área) de la curva 

hipsométrica. 

Cuadro 4.3 Resumen de resultados de valores morfológicos para la subcuenca 924. 

 

 

4.6. Morfología de la Subcuenca 926 

 

En la Figura 4.15 se observa el área correspondiente a la subcuenca 926 así como los 

cauces de los arroyos. Los parámetros de forma, drenaje y los de relieve se analizaron en 

una sola serie para esta área ver Cuadro 4.4. 

Cuenca
Área 

(km
2
)

Perímetro 

(km)

Longitud de 

la cuenca 

(km)

Cota Inicial 

del cauce 

(msnm)

Cota 

Finalde 

cauce 

(msnm)

Índice de 

Compacidad 

(K): 

Relación 

de 

elongación 

(R): 

Factor de 

forma  (F): 

Patrón de 

drenaje 

(Pd)

Subcuenca 

924
75.90 50.74 16.4 1581 1500 1.63 0.60 0.28 S/Pd

Cuenca

Número 

de orden 

de cauce.

Longitud 

total de los 

causes 

(km)

Densidad de 

drenaje

Longitud 

total Cauce 

Principal 

(km)

Pendiente 

media de la 

cuenca (%)

Pendiente 

cauce 

principal 

(%)

Altitud 

media de la 

Cuenca 

(msnm)

Altitud 

más 

frecuente: 

(msnm)

Altitud de 

Frecuencia 

media 

(msnm)

Subcuenca 

924
1 9 0.12 9 13 9 1800 1535 1808
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Figura 4.15. Área de la subcuenca 926. 
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4.6.1. Parámetros de forma. 

 

Esta subcuenca cuenta con un área de 122.18 km
2
, tiene un perímetro de 51.16 km, la 

longitud de la cuenca es de 15.60 km. El coeficiente de compacidad de Gravelius es de 

1.30, se considera una cuenca de clase II de acuerdo a la clasificación de Campos (1992) es 

Oval-redonda a oval oblonga onda. La relación de elongación es de 0.80 los valores de (R) 

inferiores a 1, implican formas alargadas. El Factor de forma de la cuenca es de 0.50 de 

acuerdo a las clases de valores de forma moderadamente achatada. 

 

4.6.2. Parámetros de drenaje 

 

El número de orden de cauce de acuerdo a la clasificación de Horton (1945) fue de clase 

baja correspondiente a un cauce de primer orden.  

Longitud total de los cursos de agua este parámetro fue medido a través de suma total de 

órdenes de cauces, el cual fue de 11 km. El resultado de este valor se utiliza para definir la 

densidad de drenaje de la cuenca. 

La densidad de drenaje fue de 0.09 es una cuenca de clase baja refleja un área pobremente 

drenada, con respuesta hidrológica muy lenta. 

 

4.6.3. Parámetros de relieve 

 

Pendiente media de la cuenca fue de 14% de acuerdo a la caracterización de relieve según 

Heras que representa un suelo medio accidentado que favorece parcialmente la escorrentía, 

favoreciendo el escurrimiento superficial y potenciando algunos procesos erosivos. La 

pendiente del cauce principal fue del 14%. 
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En la Figura 4.16 se aprecia la curva hipsométrica de la subcuenca 926 la cual presenta el 

comportamiento de la elevación y el área acumulada que proyecta la subcuenca, es posible 

señalar que esta cuenca se encuentra en la etapa intermedia (curva B) es característica de 

una cuenca en equilibrio y  la curva inferior (curva C) es típica de una cuenca sedimentaria. 

 

 

 

 

 

 

 

Figura 4.16. Curva Hipsometrica de la subcuenca 926 del arroyo La Encantada 

El polígono de frecuencia de altitudes para la subcuenca 926 del arroyo La Encantada se 

muestra en la siguiente Figura 4.17. 

 

 

 

 

 

 

 

 

 

Figura 4.17. Polígono de frecuencia de altitudes para la subcuenca 926. 
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Con las figuras de la cuerva hipsométrica y el polígono de frecuencias de alturas se 

determinan las alturas características. Altura media: 1800 msnm es la ordenada media de la 

curva hipsométrica. Altura más frecuente: 1705 msnm es la altitud cuyo valor porcentual es 

el máximo de la curva de frecuencia de altitudes. Altitud de frecuencia media: 1794 msnm 

es la altitud correspondiente al punto de abscisa media (50 % del área) de la curva 

hipsométrica. 

Cuadro 4.4 Resumen de resultados de valores morfológicos para la subcuenca 926. 

 

4.7. Morfología de la Subcuenca 928 

 

En la Figura 4.18 se observa el área correspondiente a la subcuenca 928 así como los 

cauces de los arroyos. Los parámetros de forma, drenaje y los de relieve se analizaron en 

una sola serie para esta área ver Cuadro 4.5. 
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Figura 4.18. Área de la subcuenca 928 

 

4.7.1. Parámetros de forma. 

 

Esta subcuenca cuenta con un área de 83.84 km
2
, tiene un perímetro de 43.19 km, la 

longitud de la cuenca es de 16 km. El coeficiente de compacidad de Gravelius es de 1.32, se 

considera una cuenca de clase II de acuerdo a la clasificación de Campos (1992) es Oval-

redonda a oval oblonga onda. La relación de elongación es de 0.65 los valores de (R) 

inferiores a 1, implican formas alargadas. El factor de forma de la cuenca es de 0.33 de 

acuerdo a las clases de valores de forma ligeramente achatada. 
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4.7.2. Parámetros de drenaje 

 

El número de orden de cauce de acuerdo a la clasificación de Horton (1945) fue de clase 

baja correspondiente a un cauce de primer orden.  

Longitud total de los cursos de agua este parámetro fue medido a través de suma total de 

órdenes de cauces, el cual fue de 12 km, el resultado de este valor se utiliza para definir la 

densidad de drenaje de la cuenca. 

La densidad de drenaje fue de 0.14 es una cuenca de clase baja refleja un área pobremente 

drenada, con respuesta hidrológica muy lenta. 

 

4.7.3. Parámetros de relieve 

 

Pendiente media de la cuenca fue de 33% de acuerdo a la caracterización de relieve según 

Heras representa un suelo fuerte accidentado que favorece la capacidad de arrastre de 

sedimentos e incrementa la velocidad del caudal en caso de tormentas, la pendiente del 

cauce principal fue del 28%. 

En la Figura 4.19 se aprecia la curva hipsométrica de la subcuenca 928 la cual presenta el 

comportamiento de la elevación y el área acumulada que proyecta la subcuenca es posible 

señalar que esta cuenca se encuentra en la etapa intermedia (curva B) es característica de 

una cuenca en equilibrio. 
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Figura 4.19. Curva Hipsometrica de la subcuenca 928 del arroyo La Encantada. 

El polígono de frecuencia de altitudes para la subcuenca 928 del arroyo La Encantada se 

muestra en la siguiente Figura 4.20. 

 

 

 

 

 

 

 

Figura 4.20. Polígono de frecuencia de altitudes para la subcuenca 928. 

Con las figuras de la cuerva hipsométrica y el polígono de frecuencias de alturas se 

determinan las alturas características. Altura media: 2350 msnm es la ordenada media de la 

curva hipsométrica.  Altura más frecuente: 2008 msnm es la altitud cuyo valor porcentual 

es el máximo de la curva de frecuencia de altitudes. Altitud de frecuencia media: 2292 

msnm es la altitud correspondiente al punto de abscisa media (50 % del área) de la curva 

hipsométrica. 
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Cuadro 4.5 Resumen de resultados de valores morfológicos para la subcuenca 928. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Cuenca
Área 

(km
2
)

Perímetro 

(km)

Longitud de 

la cuenca 

(km)

Cota Inicial 

del cauce 

(msnm)

Cota 

Finalde 

cauce 

(msnm)

Índice de 

Compacidad 

(K): 

Relación 

de 

elongación 

(R): 

Factor de 

forma  (F): 

Patrón de 

drenaje 

(Pd)

Subcuenca 

928
83.84 43.19 16 2037 1700 1.32 0.65 0.33 S/Pd

Cuenca

Número 

de orden 

de cauce.

Longitud 

total de los 

causes 

(km)

Densidad de 

drenaje

Longitud 

total Cauce 

Principal 

(km)

Pendiente 

media de la 

cuenca (%)

Pendiente 

cauce 

principal 

(%)

Altitud 

media de la 

Cuenca 

(msnm)

Altitud 

más 

frecuente: 

(msnm)

Altitud de 

Frecuencia 

media 

(msnm)

Subcuenca 

928
1 12 0.14 12 0.33 28 2350 2008 2292
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V. CONCLUSIONES  

 

Se obtuvieron nueve unidades hidrográficas 4 cuencas y 5 intercuencas a las cuales solo el 

área total de la cuenca y las 4 unidades tipos subcuencas se les determinó un cierto número 

de parámetros fundamentales en base a las características morfométricas de una cuenca 

hidrográfica que dieron idea de las propiedades particulares de cada cuenca; estas 

propiedades o parámetros facilitan el empleo de fórmulas hidrológicas, que generalmente 

son empíricas, y sirven para relacionarlas con los parámetros de forma, drenaje y de relieve. 

La interpretación de los parámetros morfométricos deben tomarse con cautela por que 

pueden representar valores subjetivos; sin embargo, la información aportada ofrece un 

panorama general que puede ayudar a formar diversos escenarios necesarios para prevenir 

contingencias y tomar medidas para preservar los recursos naturales de la zona. 
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VI. RECOMENDACIONES 

 

 Se recomienda seguir subdividiendo las unidades hidrográficas que aún presentan 

una importante extensión en este nivel 3 para obtener mosaicos cada vez más finos 

de la superficie del terreno y representar unidades de drenaje más pequeñas. 

  

 Realizar la caracterización de las intercuencas y subcuencas con un umbral 

independiente al generado con el área completa de la cuenca, que determine el flujo 

de acumulación adecuado para el cálculo de parámetros de cada unidad 

hidrográfica. 

 

 No obstante, que la información obtenida fue elaborada para una escala de: 

1.50.000, es posible emplear válidamente a escalas de mayor detalle, hasta un límite 

máximo de: 1:25.000. 

 

 Homogeneizar criterios de delimitación entre las distintas instituciones académicas 

y dependencias gubernamentales así como brindar una base estandarizada de 

cuencas a nivel nacional. 

 

 Con la información obtenida del área de estudio se pueden tomar nuevas medidas 

como la toma de decisiones para el diseño de obras hidráulicas futuras, establecer 

áreas vulnerables a los eventos hidro meteorológicos extremos, etc. Para ello es 

necesario realizar un estudio hidrológico a partir de los datos obtenidos en este 

trabajo. 

 

 Equilibrar los usos que se den a los recursos naturales de la cuenca ya que ello 

genera impactos negativos si no se tienen un adecuado manejo de los recursos, las 

intervenciones antropogénicas son el causante de muchos desastres dentro de la 

cuenca, ya que se sobreexplota la cuenca quitándole recursos o desnudándola de 

vegetación y trayendo inundaciones en las partes bajas. 
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